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Introduction

Features

The EPSON digital camera software suite is the perfect 
companion for your EPSON digital camera. Using this 
software together with your digital camera, you can 
save your photos as files on your computer’s hard 
disk. The following list summarizes some of the 
programs included with your PhotoPC 2100Z and 
their features.

❏ EPSON Photo!4 allows you to view and manage 
the image files saved on your camera’s memory 
card or in your computer.

❏ EPSON AutoDownloader provides a quick and 
organized way for you to transfer your photos 
from your camera to your computer.

❏ EPSON PhotoQuicker allows you to print photos 
simply and in a variety of ways using your 
computer.

❏ EPSON CardMonitor enables EPSON 
CameraStarter to start automatically by detecting 
when the camera is connected to your computer, 
or when the memory card is inserted into a PC 
Card slot.

❏ EPSON CameraStarter provides you with the 
convenient way of opening applications for 
printing and downloading the images in your 
memory card.

About This Guide

Using this guide

This online User’s Guide employs links to make 
navigation simpler. When you move the cursor over a 
link, it changes to a hand icon. You can then click the 
link to access a related topic for more detailed 
information. 
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You can also use the bookmarks in the left pane to help 
make navigation easier. Click the bookmark of the 
item you want to view to jump to that item.

Printing a topic

To print a topic, click Print on the File menu. Before 
printing, be sure to specify a Print Range for the pages 
you want to print.

The information in this guide

The information in this guide is divided into five 
chapters, with an appendix, a glossary, and an index 
provided for reference. The chapters are organized as 
follows.

❏ Chapter 1 contains instructions and information 
on installing the software, and instructions on 
making settings in CameraStarter. Be sure to read 
this chapter first.

❏ Chapter 2 explains how to connect your camera 
to your computer and how to transfer images 
from your camera to your computer.

❏ Chapter 3 provides you with a complete 
description of EPSON Photo!4.

❏ Chapter 4 explains how to use EPSON Camera 
Starter and also includes information on printing 
your photos.

❏ Chapter 5 explains how to solve problems you 
may encounter while using the software.

Additional Information

Online help also provides information about EPSON 
Photo!4 settings and the use of EPSON 
AutoDownloader.

The online EPSON PhotoQuicker User’s Guide 
contains information on using EPSON PhotoQuicker 
to print your photos.

To set up and use your digital camera, see the PhotoPC 
2100Z User’s Guide included with your camera.
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System Requirements

Before connecting your PhotoPC 2100Z digital camera 
to your computer and running the digital camera 
software, make sure that your computer meets the 
following system requirements.

For Windows

The system requirements for using the PhotoPC 2100Z 
with Windows® are as follows:

For Macintosh

The system requirements for using the PhotoPC 2100Z 
with Macintosh® computers are as follows:

Note:
The included software cannot be used with the Multiple 
Users function of Mac OS 9.

USB port (TYPE A receptacle)

At least 48 MB RAM 
(64 MB when using EPSON PhotoQuicker)

Hard disk drive with at least 50 MB of free space
(170 MB when using EPSON PhotoQuicker)

VGA monitor with at least 256-color display

Microsoft® Windows Millennium Edition, 
Windows 98, or Windows 2000 pre-installed

Power PC G3 processor or higher

Apple® Macintosh with built-in USB port

48 MB RAM 
(128 MB when using EPSON PhotoQuicker together 
with EPSON Photo!4)

Hard disk drive with at least 50 MB free space
(170 MB when using EPSON PhotoQuicker)

Monitor with a minimum resolution of 640 × 480

Macintosh OS 8.5.1 to OS 9.1
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Warnings, Cautions, and Notes

w
Warnings must be followed carefully to avoid bodily 
injury.

c
Cautions must be observed to avoid damage to your 
equipment.

Notes contain important information and useful tips on the 
operation of your software, camera, and optional equipment.
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The EPSON Camera Software CD-ROM that comes 
with your PhotoPC 2100Z digital camera contains the 
following software.

❏ PhotoPC 2100Z USB driver
This driver is necessary to connect your camera to 
your computer (except for Windows 2000 and 
Mac OS 9 users). 

❏ EPSON Photo!4
This software is for viewing and managing the 
images you capture with your PhotoPC 2100Z.

❏ EPSON CameraStarter
This utility starts automatically when you connect 
your camera to your computer and provides you 
with a convenient way to launch EPSON 
AutoDownloader and EPSON PhotoQuicker.
(Automatically installed with EPSON Photo!4.)

❏ EPSON AutoDownloader
This utility provides you with a quick and 
organized way to transfer your photos from the 
camera to your computer.
(Automatically installed with EPSON Photo!4.)

❏ EPSON CardMonitor
This utility enables EPSON CameraStarter to start 
automatically by detecting when the camera is 
connected to your computer, or when the 
memory card is inserted into a PC Card slot.

❏ EPSON PhotoQuicker
This software is for printing your images.

❏ Adobe Acrobat Reader
This software is for viewing this PDF manual 
contained on the Camera Software CD-ROM.

Installing the Software in Windows

Follow the steps below to install the software on the 
PhotoPC 2100Z Camera Software CD-ROM included 
with your PhotoPC 2100Z digital camera.

Note:
Do not connect your camera to your computer before you 
install the software.

1. Turn on the computer and insert the Camera 
Software CD into the CD-ROM drive.

If a dialog box prompts you to select a language, 
click the appropriate language, then click .
Installing and Setting up the Software 11



2. The EPSON Installation Program dialog box 
appears. Select Install Digital Camera Software, 
then click  .  

Note:
If the EPSON Installation Program dialog box does not 
appear, double-click the My Computer icon. Click 
the CD-ROM icon, select Open from the File menu, 
and double-click Setup.exe.

3. The following dialog box containing a list of 
software appears.

Software with a check mark next to it will be 
installed on your PC in the order listed. Click a 
software title in the list to remove or add a check 
mark.

Note:
❏ Be sure to install all the software when installing 

for the first time.

❏ EPSON AutoDownloader and EPSON 
CameraStarter are automatically installed when 
you install EPSON Photo!4.

❏ The USB drivers for the EPSON PhotoPC 2100Z 
and PhotoPC 3100Z cameras cannot be used 
interchangeably. Be sure to install the USB driver 
for your camera before connecting your camera to 
your computer.

❏ For a short description of each type of software, see 
page 11.

Note for Windows 2000 users:
The PhotoPC 2100Z and PhotoPC 3100Z use the USB 
driver included with Windows 2000. Therefore, 
EPSON PhotoPC 2100Z storage driver does not 
appear in the list of software and does not need to be 
installed.

4. Click OK, then follow the on-screen instructions. 

5. After installing the first software, click Finish. The 
installation process begins automatically for the 
next software that you selected in step 3.

6. Follow the on-screen instructions until all the 
software is installed.
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7. When all the software has been installed, the 
following dialog box is displayed.

Click OK, then restart your computer.

Note:
Be sure to restart your computer after you are finished 
installing software from the Camera Software CD-ROM.

Installing the Software on a Macintosh

Follow the steps in the sections below to install the 
software on the PhotoPC 2100Z Camera Software 
CD-ROM.

Note:
Do not connect your camera to your computer before you 
install the software.

Installing EPSON Photo!4 and other software

1. Turn on the computer and insert the Camera 
Software CD into the CD-ROM drive.

2. In the EPSON folder that appears on your 
computer’s desktop, double-click the icon of your 
preferred language. 

Note:
If the EPSON folder does not appear, double-click the 
EPSON icon on your desktop. 

3. Double-click the Installer icon. The following 
dialog box appears with a list of the software that 
will be installed.
Installing and Setting up the Software 13



Note:
❏ EPSON AutoDownloader and EPSON 

CameraStarter are automatically installed when 
you install EPSON Photo!4.

❏ Be sure to install all the software when installing 
for the first time.

❏ The PhotoPC 2100Z and PhotoPC 3100Z use the 
USB driver already installed in the Mac OS 9.

4. To begin installing the software, click the Start 
button. Follow the on-screen instructions.

Note for Macintosh OS 8.5.x users:
Panorama Stitcher Light EP is not available and will 
not be installed.

5. After you finish installing the software, the 
following message appears.

Click Restart to restart your computer.

Note:
Be sure to restart your computer after you are finished 
installing software.

After your computer restarts, go to the next 
section to install Acrobat Reader. 

Installing Acrobat Reader

Acrobat Reader is necessary for viewing this online 
EPSON Digital Camera Software User’s Guide. Follow 
the steps below to install Acrobat Reader.

Note:
If Acrobat Reader is already installed on your computer, 
skip to the next section to set up EPSON CameraStarter.

1. Turn on the computer and insert the Camera 
Software CD in the CD-ROM drive.

2. In the EPSON folder that appears on your 
computer’s desktop, double-click the English 
icon.

Note:
If the EPSON folder does not appear, double-click the 
EPSON icon on your desktop. 
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3. Double-click the Manual folder.

4. Double-click the Acrobat Reader folder, then 
double-click the Acrobat Installer icon.

5. Follow the on-screen instructions.

After you finish installation, go to the next section to 
set up EPSON CameraStarter.

Setting Up EPSON CameraStarter

EPSON CameraStarter is a utility that provides you 
with a convenient way to launch the EPSON 
AutoDownloader and EPSON PhotoQuicker 
software. You can then use this software to transfer 
files from your memory card to a computer, to print 
your images, or to do both in one session.

You can set up EPSON CameraStarter to open 
automatically when you connect your camera to your 
computer, or when you insert the card into a PC Card 
slot. To make these settings, follow the steps below.

c
Caution:
Never insert or remove a memory card from your 
camera while the camera is on. For instructions on 
connecting your camera to your computer, see 
“Connecting the camera to your computer” on page 
18.

Note:
❏ If you want EPSON CameraStarter to open 

automatically, you must first use the memory card 
with your PhotoPC 2100Z or PhotoPC 3100Z before 
inserting it into a PC Card slot.

❏ To start CameraStarter automatically when a memory 
card is inserted, CardMonitor must be installed. For 
instructions on installing CardMonitor, see 
“Installing the Software in Windows” on page 11 or 
“Installing the Software on a Macintosh” on page 13.

1. Start EPSON CameraStarter.

In Windows
Click Start, point to Programs, EPSON Camera, 
and then EPSON Photo!4, then click EPSON 
CameraStarter.

On a Macintosh
Double-click the EPSON Photo!4 folder, then 
double-click the EPSON CameraStarter icon.
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The EPSON CameraStarter dialog box appears.

2. Click the Settings button.

Note:
The Settings button is disabled if EPSON 
CardMonitor is not installed.

3. To make EPSON CameraStarter open 
automatically when you connect a PhotoPC 
2100Z or PhotoPC 3100Z that contains a memory 
card to your computer, or when you insert your 
memory card into your EPSON printer’s PC Card 
slot, click the Show EPSON CameraStarter 
button.

If you want CameraStarter to open automatically 
when you insert your memory card into a PC 
Card slot of a device other than your printer, such 
as your computer or a memory card reader, select 
the Monitor card insertion into Card Reader 
slots check box.

If you do not want EPSON CameraStarter to open 
automatically, click the Ignore the Event button.

4. Click OK, then click Exit.
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You can transfer your photos, video clips, and audio 
recordings from your memory card to your computer 
in a variety of ways when your camera is connected to 
your computer, or when the memory card is in a PC 
Card slot of a device such as your EPSON printer or 
memory card reader. This chapter explains how to 
transfer your files and covers the following:

❏ Connecting your camera to your computer

❏ Transferring files to your computer using EPSON 
AutoDownloader

❏ Copying files to your computer using EPSON 
Photo!4

Connecting and Disconnecting the 
PhotoPC 2100Z

Use the USB cable included with your camera to 
connect the camera to the computer. When your 
camera is connected, you can download or copy your 
photo files to the computer, or upload photo files 
saved in the computer to the memory card. 

Connecting the camera to your computer

You can connect your PhotoPC 2100Z or PhotoPC 
3100Z to a computer using the USB cable included 
with your camera.

Following instructions are for PhotoPC 2100Z users. 
For PhotoPC 3100Z users, see the User’s Guide for 
your camera.

Before connecting your camera, make sure that the 
USB driver is installed in your computer (except for 
Windows 2000 and Macintosh OS 9). For installation 
instructions, see “Installing the Software in Windows” 
on page 11 or “Installing the Software on a Macintosh” 
on page 13.
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Note:
❏ Make sure the camera’s batteries have enough power 

before connecting the camera to your computer. If the 
camera turns off automatically because of low battery 
power while connected, your computer may function 
incorrectly. EPSON highly recommends using the 
optional AC adapter whenever you connect the camera 
to your computer.

❏ Make sure a memory card is inserted in your camera. 
Otherwise, a connection will not be established.

❏ When the camera is connected to the computer, you 
cannot use the buttons other than the  button on the 
camera, and the camera’s automatic power save feature 
is disabled.

❏ Although you can connect the USB cable at any time, 
EPSON recommends connecting it in the manner 
described below.

❏ If the EPSON software does not recognize the camera 
when it is connected, see “Software Problems” on page 
51 for more information.

 To connect the camera, follow the steps below.

1. Turn on your computer.

2. Plug the cable connector into the USB port on your 
computer or the port on the USB hub connected 
directly to your computer.

c
Caution:
Be sure to use the USB cable that comes with 
your camera to avoid damaging the camera’s 
interface connector.

USB port on 
computer

USB cable
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3. Open the connector cover on the side of the 
camera and insert the other end of the USB cable 
into the interface connector as shown below. 
Make sure that the shape of the cable connector 
corresponds to the shape of the interface 
connector.

c
Caution:
Be sure to position the cable correctly before 
inserting it into the connector. Otherwise, the 
cable and connector may be damaged.

4. Press the  button to turn the camera on. The 
indicator light blinks orange.

Note for PhotoPC 2100Z users:
If the camera’s LCD monitor comes on, the camera will 
not connect to the computer. To establish a connection, 
press the camera’s  button, or see “Setting the Time 
and Date” in the PhotoPC 2100Z User’s Guide to make 
the time and date settings before connecting to the 
computer.

The first time you connect your camera to your 
computer, various windows may appear while the 
computer associates the USB driver with the camera. 
This is normal and only happens the first time the 
camera is connected.

If you have not yet installed the USB driver, a message 
asking you to locate the driver will appear. If this 
happens, cancel the operation and disconnect the 
camera from the computer. Close all applications, then 
install the USB driver following the instructions in 
“Installing the Software in Windows” on page 11 or 
“Installing the Software on a Macintosh” on page 13.

When you connect the camera, the indicator light next 
to the viewfinder blinks orange while the connection 
is being established.

c
Caution:
Keep your camera and computer away from potential 
sources of electromagnetic interference, such as 
loudspeakers or the base units of cordless telephones.

connector cover
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Disconnecting the camera from your computer

After you are finished using the camera with the 
computer, be sure to disconnect the camera correctly. 
Follow the steps in the appropriate section below.

c
Caution:
Be sure to follow these steps when disconnecting the 
camera. Doing otherwise may damage the camera or 
memory card, and could cause your computer to 
function incorrectly.

Disconnecting the camera in Windows Me and 98

1. Double-click the My Computer icon on the 
desktop. The My Computer window appears.

2. Right-click the Removable Disk icon, then click 
Eject. The Removable Disk icon disappears.

3. Press the  button to turn off the camera.
The indicator light goes off. Then disconnect the 
USB cable.

Disconnecting the camera in Windows 2000

1. Double-click the eject icon on the task bar.

The Unplug or Eject Hardware dialog box 
appears.

Note:
Alternatively, you can display the Unplug or Eject 
Hardware dialog box by right-clicking the eject icon, 
then clicking Unplug or eject hardware.

2. Click the Stop button. The Stop a Hardware 
device dialog box appears.

3. Select USB Mass Storage Device, then click the 
OK button. 

4. A confirmation message appears. Click OK.

Note:
❏ If the Problem Ejecting USB Mass Storage Device 

window appears, click the OK button and restart 
the operation from step 1.

eject icon
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❏ You can also disconnect the camera by clicking the 
eject icon on the task bar once, then clicking Stop 
USB Mass Storage Device, and clicking OK.

5. Press the  button to turn off the camera.
The indicator light goes off.

Disconnecting the camera from a Macintosh

1. On the desktop, move the EPSON_DSC icon into 
the Trash.

2. Press the  button to turn off the camera.
The indicator light goes off. Then remove the USB 
cable.

Using EPSON AutoDownloader to Transfer 
Images

EPSON AutoDownloader is a utility that allows you 
to quickly download photos from your camera to a 
designated folder on your computer. 

This utility gives you complete control over the 
download process, helping you to organize and 
manage your files. It allows you to:

❏ Designate the location and name of a base folder 
to which your files will be downloaded.

❏ Download files to subfolders within the base 
folder, and have the subfolders automatically 
named by the date of the download session or the 
date that the photos were taken.

❏ Automatically name files while downloading. 
You can choose to name them using the EPSON 
photo file format, using the date and time that 
they were taken, or using the date and sequence 
in which they were taken.

Once the files are downloaded to your computer, you 
can use EPSON Photo!4 to view and manage your 
images. For instructions, see Chapter 3, “Using 
EPSON Photo!4.”

For more information on EPSON AutoDownloader, 
see EPSON AutoDownloader’s online help.

Using EPSON AutoDownloader with Windows

To open EPSON AutoDownloader in Windows, 
follow the steps below.

1. Make sure that your camera is connected to your 
computer, and that they are both turned on. If 
necessary, see “Connecting the camera to your 
computer” on page 18.
Transferring Images to Your Computer 22



2. Click Start, point to Programs, EPSON Camera, 
and then EPSON Photo!4, then click EPSON 
AutoDownloader. The main download dialog 
box appears.

3. To begin downloading, click the Start button.

To make download settings, click the Settings 
button. You can make settings on the Files and 
Folders and Advanced menus.

Note:
❏ For more information on making settings, click the 

Help button.

❏ To make settings before opening the main 
download dialog box, click the Start button, point 
to Programs, EPSON Camera, and then 
EPSON Photo!4, then click EPSON 
AutoDownloader Settings.

Using EPSON AutoDownloader on a Macintosh

To access EPSON AutoDownloader using a 
Macintosh, follow the steps below.

1. Make sure that your camera is connected to your 
computer, and that they are both turned on. If 
necessary, see “Connecting the camera to your 
computer” on page 18.

2. Double-click the EPSON Photo!4 folder, then 
double-click the EPSON AutoDownloader icon. 
The main download dialog box appears.

3. To begin downloading, click the Start button.

To make download settings, click the Settings 
button. You can make settings on the Files and 
Folders and Advanced menus.

Note:
❏ For more information on making settings, click the 

Help button.

❏ To make settings before opening the main 
download dialog box, double-click the EPSON 
Photo!4 folder and then the EPSON 
AutoDownloader Settings icon.
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Accessing EPSON AutoDownloader from EPSON 
CameraStarter

You can also access EPSON AutoDownloader from 
the EPSON CameraStarter utility. Follow the steps 
below. 

1. Start EPSON CameraStarter.

In Windows
Click Start, point to Programs, EPSON Camera, 
and then EPSON Photo!4, then click EPSON 
CameraStarter.

On a Macintosh
Double-click the EPSON Photo!4 folder, then 
double-click the EPSON CameraStarter icon.

The EPSON CameraStarter dialog box appears.

2. To open EPSON AutoDownloader, click one of 
the following icons.

❏ The  SAVE icon
Click this icon when you want to transfer files 
from your memory card to your computer.

❏ The  SAVE & PRINT icon
Click this icon when you want to transfer files 
from your memory card to your computer, 
then print them using EPSON PhotoQuicker.

The main dialog box of EPSON AutoDownloader 
appears.

Note:
❏ To use the SAVE & PRINT icon, EPSON 

PhotoQuicker must be installed in your computer. 
For installation directions, see “Installing the 
Software in Windows” on page 11 or “Installing 
the Software on a Macintosh” on page 13.

❏ If you click the SAVE & PRINT icon, EPSON 
PhotoQuicker software will start automatically 
after the files are finished being transferred to your 
computer, regardless of the settings you make in 
EPSON AutoDownloader.

❏ You can set EPSON CameraStarter to start 
automatically. For details, see “Setting Up 
EPSON CameraStarter” on page 15.

3. To begin downloading, click the Start button.

To change download settings, click the Settings 
button. You can make settings on the Files and 
Folders and Advanced menus.

Note:
For more information on making settings, click the 
Help button.
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EPSON Photo!4 helps you view and manage the image 
and audio recording files saved on your camera’s 
memory card or in your computer. You can use 
Photo!4 to organize your files, view your photos in a 
variety of ways, and play back audio recordings and 
video clips. EPSON Photo!4 also allows you to upload 
EPSON Photo file format images to your camera’s 
memory card, prepare your files to be sent over the 
Internet via e-mail, and use your images as a 
background for your desktop.

Note:
See online help for more information on using EPSON 
Photo!4. To open help, click the  icon in EPSON Photo!4.

Starting EPSON Photo!4

Follow the instructions in this section to open EPSON 
Photo!4.

For Windows users

Click Start, point to Programs, EPSON Camera, and 
then EPSON Photo!4, then click EPSON Photo!4. The 
main window of EPSON Photo!4 appears.

For Macintosh users

Double-click the EPSON Photo!4 icon in the EPSON 
Photo!4 program group or folder. The main window 
of EPSON Photo!4 appears.
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Viewing Your Images

EPSON Photo!4 includes many features for viewing 
images on the camera’s memory card, or images that 
have been imported from the camera to the computer. 
You can display thumbnails of your images or video 
clips, or display a list that shows more information 
regarding the images. You can also display a larger 
image or play back video clips with the Image Viewer 
window, watch a slide show of your images, and play 
back audio clips. Use the Photo!4 search function to 
find files according to file name, date taken, or other 
conditions of your choice.

Selecting folders and drives that contain 
images

The EPSON Photo!4 main window is divided into left 
and right panes. The left pane shows a list of the 
computer’s drives and folders, and the right pane 
shows thumbnails or a list of the EPSON Photo file 
format image files in a selected folder or drive.

Click a drive or folder to view its contents.
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Note:
❏ Only EPSON Photo file format image files are 

displayed in the right pane.
If no EPSON Photo file format image files are in the 
selected folder, No Images appears in the right pane.

❏ To update the contents of the left pane, select Refresh 
from the View menu. Changes to the folders and drives 
in your computer will be reflected in the left pane.

To view all the folders and drives accessible from your 
computer, click All Folders at the top of the left pane.

To display only folders that contain images, click 
Image Folders at the top of the left pane. Only the 
following folders are displayed:

❏  Base Folder 
You can change the name or location of this folder 
by selecting Settings from the Edit menu, then 
specifying a new folder in the Base Folder list box.

❏  EPSON Camera
This drive appears only when the memory card is 
in your PhotoPC 2100Z or PhotoPC 3100Z and the 
camera is connected to your computer.

❏  Camera Card
This drive appears when the memory card is 
inserted into the PC Card slot of another device, 
such as your EPSON printer or a memory card 
reader.

❏  Recent Search Results
This folder contains the results of your most 
recent searches using the EPSON Photo!4 search 
function. To use this function, see “Displaying 
thumbnail images or a list of files” on page 29.

Image files in memory cards are located in the 
following folders:

❏ ✽✽✽ EPSON
This folder is created when photo data is stored 
in the memory card for the first time. It is created 
inside the DCIM folder and contains photo files, 
which end with either the JPG or TIF extension.

Note:
The PhotoPC 2100Z saves image files in the 
automatically generated ✽✽✽ EPSON folder, where 
✽✽✽ represents any number from 100 to 999.

❏ MOVIE
This folder contains movie clip files that end with 
the MOV extension.
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Note:
This folder is only made by EPSON digital cameras 
that can take movie clips.

Displaying thumbnail images or a list of files

You can display images in the right pane as 
thumbnails of various sizes or as a list of files. Click 
the following buttons in EPSON Photo!4 to change the 
display size.

You can reverse the order in which the images or files 
appear by clicking the arrow icon in the upper right 
corner of the right pane. When viewing a list of files, 
you can change the order in which the files appear by 
clicking an item at the top of the right pane.

Note:
Audio recording files are not displayed. See “Playing back 
audio recordings” on page 35 to play back recordings 
associated with a photo.

Selecting images

Click an image file to select it. You can select a group 
of images by dragging the cursor over them, or by 
clicking the images while holding down the Shift key 
on your keyboard. You can also select multiple images 
by holding down the Ctrl key (Windows) or Option 
key (Macintosh) while clicking the images.

To select all the files in the selected folder or drive, 
click the  button, or click Select All on the Edit 
menu.

Viewing image information

EPSON Photo!4 allows you to view information about 
image files in a variety of ways. You can display 
information icons in the margins of thumbnails, show 
or hide a variety of file details at the top of a list of files, 
and access all the available information on a selected 
image by using the Properties dialog box. The 
following sections explain how. 

Click this button... To display...

Large Thumbnails

Medium Thumbnails (Default)

Small Thumbnails

Details
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Note:
The following information is not displayed for video clips, 
image quality, file format symbols, or stitching information.

Displaying information in thumbnails

You can display information icons on the left side of 
the thumbnails by clicking the  icon, or by selecting 
Image Info from the View menu. The information 
icons indicate the type of image file and the settings 
used when the image was captured, as explained 
below.

❏ File format icons:
 appears if the image is a JPEG file that 

conforms to the “Design rule for camera file 
system,” the standard recording system for image 
files. 

 appears for images that are uncompressed 
TIFF files.

 appears if the file is a video clip.

❏ Image quality icon:
 appears for HyPict,  for Print, and  for 

e-mail.

 appears for HyPict,  for super-fine,  for 
fine, or  for standard.

Note:
Depending on the model, the image quality icons may 
vary.

❏  appears if the photo is locked.

❏ Stitching icons:
 appears if the photo is the first in a series of 

photos taken using the PhotoPC 3100Z’s stitch 
assist function.

❏  appears if the photo was taken using the 
PhotoPC 3100Z’s stitch assist function, but was 
not the first photo taken in the series.

❏ Audio recording icon: 
 appears if the photo has an associated audio 

recording. Click this icon to play back the 
recording.

You can also display other image information at the 
bottom of the thumbnail. From the View menu, select 
Image Title, then click the items described below to 
show or hide that information. A check mark appears 
next to items that are currently being displayed.

❏ Filename
Click to show or hide the name of the image file.
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❏ Date Taken
Click to show or hide the date and time that the 
image was taken.

❏ Stitching Location
Click to show or hide information about the 
location of the photo in a series of photos taken 
with the PhotoPC 3100Z’s stitch assist feature. No 
information is shown for images that were taken 
without using the stitch assist feature.

❏ Image Number
Click to show or hide the number that EPSON 
Photo!4 assigns to each image.

❏ User Comment
Click to show or hide the user comment for the 
image. See “Using the Properties dialog box” on 
page 32 for more information.

Note:
If there is not enough room to display all of the information 
at the bottom of the thumbnail, switch to a larger thumbnail 
view by clicking the  or  buttons. 

Displaying information in a list of files

When viewing a list of files in the right pane of the 
main window, you can specify what information is 
displayed for each file in the list. 

Note:
To display a list of files, see “Displaying thumbnail images 
or a list of files” on page 29.

Showing and hiding file format information

To display a symbol that indicates the format of the 
file, click the  button. One of the following symbols 
appears.

 appears if the image is a JPEG file that 
conforms to the “Design rule for camera file 
system,” the standard recording system for image 
files. 

 appears for images that are uncompressed 
TIFF files.

 appears if the file is a video clip.

Click the  button to hide this information. 

Showing and hiding information fields

You can specify what information fields are shown in 
the file list by using the Details View menu in the 
Settings dialog box. 

To change which items are shown or hidden, follow 
the steps below.
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Note:
See online help for details on the available information fields.

1. From the Edit menu, select Settings.

2. Click the Details View tab to display the Details 
View menu.

3. Use the Available Fields and Displayed Fields 
boxes to arrange the items you want to show or 
hide.

Click the  and  buttons to move selected 
items between the Available Fields and Displayed 
Fields boxes.

Click the  and  buttons to change the order 
of selected items in the Displayed Fields box.

4. You can return all the items to their original 
positions by clicking the Default button.

5. Once you are satisfied with your settings, click OK 
to save them.

Using the Properties dialog box

The Properties dialog box allows you to view all 
available information on your image files at once. You 
can also create or modify the user comment for a 
selected image in this box. Follow the steps below.

1. Select Properties from the File menu. The 
Properties dialog box appears.
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2. Click a thumbnail or file in the right pane. 
Information about that image appears in the 
Properties dialog box.

Note:
If you select multiple images, only the number of 
selected images and the total file size in KB and bytes 
is displayed.

Click the minus (-) and plus (+) signs on the right 
side of the dialog box to hide and show the 
information in that section.

To create or modify a user comment for a selected 
image, click the Edit Comment button, type your 
text in the text box, then click the OK button to 
save your changes.

Note:
The user comment function is only available for images 
taken with the PhotoPC 2100Z and PhotoPC 3100Z.

3. With the Properties dialog box still open, click a 
different image to view properties for that image.

You can also select multiple images to view the 
total file size for the selected group of images.

4. Click Close to close the Properties dialog box.

Viewing photos in the Image Viewer window

The Image Viewer window allows you to view 
enlarged versions of photos and to play back video 
clips. You can open more than one Image Viewer 
window at a time.

minus signs
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To open an Image Viewer window, double-click a 
thumbnail or file in the right pane of the main 
window. The window like the one below appears.

You can also click the  button to open one or more 
selected images. If you selected multiple images, 
thumbnails of those images appear in the left side of 
the window.

Use the buttons in the Image Viewer window to view 
and manage your images as explained.

Use this button... To...

View the previous image.
This button is disabled when the first 
image is being viewed.

View the next image.
This button is disabled when the last 
image is being viewed.

Open another Image Viewer window.

Fit the size of the image to the window.

Show the image in its original size.

Zoom in on the image.

Zoom out.

Play back the audio file.

Rotate the image 90 degrees to the 
left.

Rotate the image 90 degrees to the 
right.

Display thumbnails of selected 
images, or all the images in the 
selected folder or drive.

Hide the thumbnails.

Use this button... To...
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Note:
❏ The PhotoPC 2100Z creates JPEG files only.

❏ To play back audio recordings on the Macintosh, 
QuickTime 4.1.2 must be installed.

❏ To display user comments in a list of files, see 
“Displaying thumbnail images or a list of files” on page 
29.

❏ Depending on the model of your camera, you may not 
be able to play back audio recordings, video clips, or 
TIFF files. For more information on your camera’s 
features, see the User’s Guide for your camera.

Playing back audio recordings

If a photo has an associated audio recording, you can 
play the recording back by selecting the photo and 
clicking the  button, or by selecting Audio 
Recording from the Image menu, then clicking Play. 
To stop the playback, click the  button again. 

Note:
❏ You cannot play back audio recordings with the 

PhotoPC 2100Z.

❏ Macintosh users need QuickTime 4.1.2 or later to play 
back audio recordings.

Playing back video clips

To play back a video clip, double-click its thumbnail 
or file, or click the thumbnail or file to select it then 
click the  button. The first frame of the clip is 
displayed in the Image Viewer window. Use the 
controls to play back your clip.

Note:
❏ Depending on the model, your camera may not be able 

to play back video clips. For more information on your 
camera’s features, see the User’s Guide for your 
camera.

❏ You need QuickTime 4.1.2 or later to play back video 
clips.

❏ For details on using the Image Viewer window, see 
“Viewing photos in the Image Viewer window” on 
page 33.

Viewing a slide show

EPSON Photo!4 allows you view slide shows of 
selected photos.

See the next sections for information on making slide 
show settings and running slide shows. 
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Making slide show settings

To make settings for your slide shows, follow the steps 
below.

1. From the Edit menu, select Settings.

2. Click the Slideshow tab to display the Slideshow 
menu.

3. Make the Picture size settings. 

Click Original Size to display images without 
modifying their size.

Click Fit to Screen to modify the size of an image 
so that it fits the size of your monitor. To display 
images that are smaller than your monitor 
without modifying their size, select the Original 
Size for Small Pictures check box.

4. Make Playback Control settings.

To advance each photo automatically, select Auto 
Advance. Specify the interval between the 
photos by typing a value in the Interval box or by 
moving the slider below the box.

To repeat the slide show automatically, select 
Repeat.

To play back audio recordings along with the 
photos, select Play Audio Recording.

If you want to display the slide show Control 
Panel when the slide show starts, select the Show 
Control Panel check box.

Note:
If the Play Audio Recording check box is selected, 
the photo will not automatically advance until the 
recording has finished playing, regardless of the setting 
in the Interval box.

5. In the Picture Title box, select the image 
information you want to see during the slide 
show.

Show Filename, Show User Comment, and 
Show Date and Time are all selected as the 
default setting.

6. Click OK to save your settings, or click the 
Default button to return all the items to their 
original settings.

Go to the next section to start your slide show.
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Running a slide show

To start and control a slide show, follow the steps 
below.

Note:
❏ You can view only the first frame of a video clip during 

the slide show. You cannot play back the clip.

❏ Images are shown in the order they appear in the right 
pane of the main window.

1. Select the images you want to include in the slide 
show. If one or no images are selected, all files 
displayed in the right pane will be included in the 
slide show. 

2. From the Image menu, select Slideshow. The slide 
show begins.

You can advance to the next image by left-clicking 
your mouse button.

3. You can control the slide show by clicking the 
buttons in the control panel.

See below for an explanation on using the buttons 
in the control panel.

If the Control Panel does not appear when the 
slide show starts, press the Esc key on your 
keyboard to display the panel. Press the Esc key 
again to hide the panel.

control panel 
for slide shows

Button Function

Click to show the previous image. 
Disabled when the first image of the slide 
show is displayed.

Click to show the next image. 
Disabled when the last image of the slide 
show is displayed.

Click to play the associated audio 
recording. 
Disabled for photos with no recording, 
and for video clips.

Click to pause the slide show.

Click to resume playing the slide show.

Click to exit the slide show and return to 
the main window.
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Using the search function

EPSON Photo!4 provides a powerful search function 
to help locate your image files. Follow the steps below 
to use the search function.

1. Select the folder to be searched in the left pane.

2. From the File menu, select Search. The Search 
dialog box appears.

3. If you also want to search subfolders, put a check 
in the Search Subfolders check box.

4. To further narrow your search, make settings in 
the fields under Search By. See online help for 
details on using these fields.

Note:
Images that meet all of the conditions you specify will 
be found.

If you select the Remember These Search 
Conditions check box, the settings you made in 
the fields under Search By are saved. The next 
time you open the Search dialog box, those search 
settings are made automatically.

If you click the Reset button, the fields under 
Search By return to their default settings.

After clicking Search, the Recent Search Results 
folder is selected in the left pane and any images 
that are found are displayed in the right pane. If 
no images are found, No Images appears.

Managing Your Images

EPSON Photo!4 includes many convenient features 
for managing your images. In addition to changing a 
file’s name, you can also lock important files to protect 
them from being accidentally deleted, and you can 
upload files to a memory card. EPSON Photo!4 also 
allows you to add comments to files, rotate images, 
and send files via e-mail.

Locking and unlocking files

You can lock files to prevent them from accidentally 
being modified or deleted. To lock or unlock files, 
follow the steps below.

Note:
❏ The  icon will appear when a file is locked.

❏ Locking or unlocking a photo that has an audio 
recording also locks or unlocks the recording.
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1. Select an image or images in the right pane of the 
main window.

2. Select Lock from the Image menu to lock the 
images. Select Unlock to unlock them.

Changing file and folder names

To change the name of a file, follow the steps below.

Note:
❏ You cannot change the names of drives using EPSON 

Photo!4.

❏ When you change the name of a photo file that has an 
associated audio file, the name of the associated audio 
file also changes to the same name.

1. Select the file or folder whose name you want to 
change.

2. From the File menu, select Rename. The Rename 
dialog box appears.

3. Type a new file or folder name, then click the OK 
button.

Deleting files

To delete one or more files, follow the steps below.

1. Select an image or images in the right pane of the 
main window.

2. From the File menu, select Delete. A message 
appears asking you to confirm the deletion.

3. Click Yes to delete the selected images; click No 
to cancel the operation.

Moving and copying files

You can use the drag-and-drop method to move or 
copy files by dragging the image in the right pane to 
a folder in the left pane.

Moving files

1. Select an image or images in the right pane of the 
main window.

2. To move the image to another folder in the same 
drive, drag the image to the desired folder in the 
left pane.
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To move the image to a folder in a different drive, 
drag the image to the desired folder in the left 
pane while holding down the Shift key (for 
Windows), or the Ctrl key (for Macintosh).

Copying files

1. Select an image or images in the right pane of the 
main window.

2. To copy the image to another folder in the same 
drive, drag the image to the desired folder in the 
left pane while holding down the Ctrl key (for 
Windows), or the Option key (for Macintosh).

To copy the image to a folder in different drive, 
drag the image to the desired folder in the left 
pane.

Uploading files to a memory card

You can use EPSON Photo!4 to upload images from 
your computer to a memory card inserted in your 
camera or another device’s PC Card slot. 

Once your camera or other device is connected to your 
computer, select the images you want to upload, then 
select Upload from the File menu. Then select the 
drive with the memory card and click the OK button 
to upload the files. 

If any of the photos that you select to upload have 
audio recordings attached, you can choose to upload 
both the photos and audio recording files, or just the 
photos.

Note:
❏ Depending on the model of your camera, you may not 

be able to play back audio recordings, video clips, or 
TIFF files. For more information on your camera’s 
features, see the User’s Guide for your camera.

❏ Files that were not originally downloaded from the 
camera cannot be uploaded using this feature.

Adding user comments

You can add comments to photos taken with your 
PhotoPC 2100Z and PhotoPC 3100Z, and video clips 
taken with your PhotoPC 3100Z. User comments are 
useful for recording personal notes and other 
additional information about your images.
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You can have your comments appear in slide shows, 
in the Properties dialog box, and in the right pane of 
the main window when viewing a list of files. You can 
also use EPSON Photo!4’s search function to find 
images based on the text in the user comments. 

Note:
❏ You can only add comments to images taken with the 

PhotoPC 2100Z and PhotoPC 3100Z.

❏ To display user comments in a list of files, see 
“Displaying thumbnail images or a list of files” on page 
29.

❏ To include comments in a slide show, see “Making slide 
show settings” on page 36.

❏ For information on using EPSON Photo!4’s search 
function, see “Displaying thumbnail images or a list of 
files” on page 29.

Follow the steps below to create or modify a user 
comment.

1. Select an image in the right pane. 

2. From the Image menu, select Edit Comment. The 
Edit User Comment dialog box appears.

3. Type your comment in the text box, then click OK 
to save your comment.

You can modify user comments in the Properties 
dialog box. See “Using the Properties dialog box” on 
page 32 for details.

Rotating your photos

Once photos are downloaded to your computer’s hard 
disk, you can rotate most of them clockwise or 
counterclockwise without decreasing the image quality. 
Select a thumbnail in the right pane of the main window 
and click the  button to rotate the image 90 degrees 
to the right, or the  button to rotate the image 90 
degrees to the left.

Note:
❏ When rotating certain images, there may be a loss in 

image quality depending on the direction and angle of 
rotation. If so, a message will appear asking you to 
confirm the rotation.

❏ You cannot rotate video clips. You cannot rotate photos 
in a memory card in your camera or other device 
connected to your computer, or that are locked.

❏ Images taken by cameras other than EPSON cameras 
cannot be rotated. 
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Using a photo as wallpaper

Follow the steps below to use an image as your 
computer’s desktop background.

1. Select a photo in the right pane of the main 
window.

2. From the Image menu, select Set as Wallpaper. 
The Set as Wallpaper dialog box appears.

3. Click Fit To Screen, Center, or Tile to specify the 
size and position of the image. You can see the 
results of your selection in the preview window 
on the left side of the dialog box.

To remove an image that is currently being used 
as wallpaper, click Remove Wallpaper.

4. Click OK.

Sending files via e-mail

EPSON Photo!4 helps you prepare files for e-mail 
transmission quickly and easily. With the Send via 
E-mail feature, you can modify the file size, calculate 
the total amount of data to be sent, and attach files to 
an e-mail message using your favorite e-mail 
program. You can also save the prepared image 
instead of sending it right away.

Note:
Using EPSON Photo!4, you can attach files directly to 
e-mail messages. For a list of the e-mail applications you can 
use with this feature, see the README file for EPSON 
Photo!4. To send files using other e-mail programs, first 
save the images to your computer’s hard disk by using the 
Save button in step 5 below.

Follow these steps to prepare your images for 
transmission via e-mail.

1. Select an image or images in the right pane of the 
main window.

2. From the Image menu, select Send via E-mail. 
The Send via E-mail dialog box appears.

3. Select the check boxes of the items you want to 
send.
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To send the photo files without reducing their 
size, click Send ’Original Size’ photos. 

To change the size of the photo files you send, 
click Send ’Reduced Size’ photos, then select a 
setting in the Photo Reduction Setting list box.

When you click the Calculate button, the 
reduced size is automatically calculated. The 
calculated size is shown under File Size, and 
Estimated Total changes to Total. The Calculate 
button changes to light gray and cannot be used. 
If you change the setting in the Photo Reduction 
Setting list box, the Calculate button becomes 
enabled again. Click the Calculate button again 
to calculate the reduced size of the new setting.

Note:
If you select Send ’Reduced Size’ Photos, a 
temporary file is created. The size of the temporary file 
is changed, and the temporary file is attached to the 
e-mail message.

4. If you are using a Macintosh, select the e-mail 
program you want to use from the Select E-mail 
Application Script list box.

Note:
If you are using Windows, use the e-mail program that 
is set for your regular use.

5. When you are satisfied with your settings, click 
the Send button, the Save and Send button, or 
the Save button.

Click the Send button to automatically attach the 
selected files to an e-mail message. The selected 
files are not saved to the computer’s hard disk.

Click the Save and Send button to automatically 
save the files to the computer’s hard disk and then 
immediately attach them to an e-mail message.

Click the Save button to save the selected files to 
the computer’s hard disk. The selected files are 
not attached to an e-mail message.

6. If you clicked the Send button in step 5, an e-mail 
program opens. Use the program to send your 
message with the files attached.

If you clicked the Save and Send button in step 
5, specify a folder in which to save the files, then 
click OK. Then, your e-mail program opens. Use 
the program to send your message with the files 
attached.

If you clicked the Save button in step 5, specify a 
folder in which to save the files, then click OK. The 
files are saved in the specified folder for later use 
according to the settings you made.
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Printing photos

You can use EPSON Photo!4 to select photos for 
printing, then to start EPSON PhotoQuicker to print 
the selected photos. Make sure that EPSON 
PhotoQuicker is installed on your computer. For 
installation instructions, see “Installing the Software 
in Windows” on page 11 or “Installing the Software 
on a Macintosh” on page 13.

Note:
❏ You cannot print video clips.

❏ For instructions on printing with EPSON 
PhotoQuicker, see the software’s documentation.

Follow the steps below.

1. Select a photo or photos in the right pane of the 
main window.

2. From the File menu, select Print. EPSON 
PhotoQuicker starts. Use EPSON PhotoQuicker 
to print the photos.

Note for Macintosh users:
To start EPSON PhotoQuicker from EPSON Photo!4, 
make sure that there are 128 MB of memory available 
in your system. To change the amount of available 
system memory on your Macintosh, see your 
computer’s documentation.
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Your camera comes with a number of utility programs 
in addition to EPSON Photo!4. This chapter tells you 
how to use these programs and covers the following 
topics:

❏ Using EPSON CameraStarter to start EPSON 
AutoDownloader or EPSON PhotoQuicker, in 
order to download or print photos from PhotoPC 
2100Z’s (or PhotoPC 3100Z’s) memory card.

❏ Using EPSON PhotoQuicker to print photos that 
are saved on your camera’s memory card, or that 
have already been saved on your hard disk.

Using EPSON CameraStarter

EPSON CameraStarter provides a convenient way to 
launch EPSON AutoDownloader and EPSON 
PhotoQuicker so that you can transfer files from your 
memory card to a computer, print your images, or do 
both in one session.

Note:
❏ For more information on using EPSON 

AutoDownloader, see “Using EPSON 
AutoDownloader to Transfer Images” on page 22. 

❏ For more information on using EPSON PhotoQuicker, 
see “Accessing EPSON PhotoQuicker” on page 49.

Follow the steps below to use EPSON CameraStarter. 

1. Connect the PhotoPC 2100Z to your computer as 
explained in “Connecting the camera to your 
computer” on page 18.

2. Start EPSON CameraStarter as described below.

For Windows Users
Click Start, point to Programs, EPSON Camera, 
then EPSON Photo!4, and then click EPSON 
CameraStarter.
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For Macintosh Users
Double-click the EPSON Photo!4 folder, then 
double-click the EPSON CameraStarter icon.

Note:
EPSON CameraStarter may start automatically when 
you connect your camera, depending on the settings in 
the Settings dialog box. For more information, see 
“Setting Up EPSON CameraStarter” on page 15.

The EPSON CameraStarter dialog box appears.

3. Check the information that appears after Source 
Drive. 

If EPSON_DSC appears, CameraStarter detects 
your camera’s memory card. Go to the next step.

Note:
If you changed the name of your memory card, the new 
memory card name appears after Source Drive instead 
of EPSON_DSC. In this case, go to the next step.

If <Please Select> appears after Source Drive, 
CameraStarter has detected more than one 
memory card, and you need to select the memory 
card whose images you want to access. Click the 
Select Drive button, then select a memory card 
from the list box and click OK.

If <None Found> appears after Source Drive, 
make sure the camera is properly connected to 
your computer and the indicator light is blinking 
orange, and that the memory card is properly 
inserted in the PC Card slot. 
Then click the Select Drive button. When 
CameraStarter detects your memory card, 
EPSON_DSC appears after Source Drive.

4. Click one of the following icons to start the 
desired software.

printer icons

name of 
detected 
memory card
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 SAVE

Click this icon to start EPSON AutoDownloader 
in order to transfer files from your memory card 
to your computer.

 PRINT

Click this icon to start EPSON PhotoQuicker in 
order to print the images in the memory card. 

❏ If the printer icons turn gray, EPSON 
PhotoQuicker loads all of the photos in the 
memory card.

❏ If the printer icons turn green, a message 
appears asking whether you want to print 
according to the DPOF settings that you 
made. If you click OK, PhotoQuicker loads 
only photos for which the number of prints 
have been specified.

 SAVE & PRINT

Click this icon to start EPSON AutoDownloader 
and EPSON PhotoQuicker in succession. After 
using EPSON AutoDownloader to transfer files 
from your memory card to your computer, 
EPSON PhotoQuicker automatically starts, 
allowing you to print your photos.

❏ If the printer icons turn gray, EPSON 
PhotoQuicker loads all of the photos that 
were downloaded.

❏ If the printer icons turn green, a message 
appears asking whether you want to print 
according to the DPOF settings that you 
made. If you click OK, PhotoQuicker loads 
only photos for which the number of prints 
have been specified.

Note:
Green printer icons in the EPSON CameraStarter 
dialog box indicate that a setting was made using the 
camera to specify the number of prints for one or more 
photos in the memory card. 
Gray printer icons indicate that no print settings were 
made.
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Accessing EPSON PhotoQuicker

EPSON PhotoQuicker is a software application for 
printing digital images.

You can use PhotoQuicker to do the following.

❏ Print photos in various layouts

❏ Print photos on postcards, roll paper, or other 
types of paper

❏ Apply various effects to images for printing

Follow the steps below to start EPSON PhotoQuicker.

For Windows users

Click Start, point to Programs, and then EPSON 
PhotoQuicker, then click EPSON PhotoQuicker3.X 
The main window of EPSON PhotoQuicker appears.

Note:
Click the Help icon for information on using EPSON 
PhotoQuicker.

For Macintosh users

Double-click the EPSON PhotoQuicker3.X icon in the 
EPSON PhotoQuicker3.X program group or folder. 
The main window of EPSON PhotoQuicker appears.

Note:
Click the Help icon for information on using EPSON 
PhotoQuicker.
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Your camera’s software is easy to use, and most 
problems that you encounter can be solved quickly 
and easily.

Refer to this section for solutions to common problems 
that may occur while using EPSON Photo!4.

Software Problems 

Find your problem in the list below, then try the 
solutions listed.

You cannot find your images in EPSON Photo!4.

When searching for images in the memory card, 
look in the ✽✽✽ EPSON folder (inside the DCIM 
folder) for photos, and the MOVIE folder for 
video clips.

Note:
❏ Depending on the model, your camera may not be 

able to take TIFF files or video clips. For more 
information on your camera’s features, see the 
User’s Guide for your camera.

❏ The PhotoPC 2100Z saves files in the automatically 
generated ✽✽✽ EPSON folder, where ✽✽✽  
represents any number from 100 to 999.

From the View menu, select Refresh to update the 
contents of the main window.

The drive for your camera does not appear in the left 
pane of the EPSON Photo!4 main window when you 
connect the camera to your computer. 

Make sure you are using the EPSON PhotoPC 
2100Z or PhotoPC 3100Z digital camera. EPSON 
Photo!4 cannot recognize any other camera 
models.

Make sure that the cable is connected correctly, as 
described in “Connecting the camera to your 
computer” on page 18.

Make sure that the indicator light next to the 
viewfinder is blinking orange.

Make sure that the batteries have enough power 
and are installed correctly, or use the optional AC 
adapter when connecting the camera to your 
computer.

Make sure that your camera has a memory card 
installed. If not, press the  button on the back 
of your camera to turn it off, insert a memory card, 
then press the  button again to turn the camera 
back on.
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If the computer’s power save feature turns on 
while the camera is connected, the camera may 
automatically turn off causing it to be 
disconnected. Try connecting the camera to the 
computer again. To avoid this problem, do not use 
your computer’s power save feature when 
connecting the camera.

In EPSON Photo!4, from the View menu, select 
Refresh to update the contents of the left pane.

Make sure that the port to which your camera is 
connected is properly configured, and that the 
Base I/O port address and the Interrupt Request 
Number (IRQ) assigned to the port are not in 
conflict with other devices.

If you are using a Macintosh, make sure that the 
USB driver extension for your camera is selected 
in the Extensions Manager, or is located in the 
Extensions folder.

Try connecting the USB cable to another port on 
the USB hub.

Try connecting the camera directly to the USB 
port on your computer using the USB cable.

Try using a different USB hub if you have one.

An error message appears when you are using 
EPSON CameraStarter.

When you connect your camera to your 
computer

Make sure that the cable is connected correctly, as 
described in “Connecting the camera to your 
computer” on page 18.

Make sure that the indicator light is blinking 
orange.

Make sure that the batteries have enough power 
and are installed correctly, or use the optional AC 
adapter when connecting the camera to your 
computer.

Make sure that the computer has enough memory 
and disk space.

Avoid opening or working with applications 
unrelated to the photo transfer process while the 
camera and computer are communicating.
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When you insert the memory card into the PC 
Card slot of another device

Make sure the memory card is correctly inserted 
into the PC Card slot, and that your device is 
correctly connected to your computer and is 
turned on. For information on connecting your 
device to your computer, see the documentation 
for your device.

Note:
While the camera and computer are communicating, 
star icons move continuously across the camera's 
display panel.

Nothing happens when you click the SAVE, PRINT, 
or SAVE & PRINT icons in EPSON CameraStarter.

To print images, make sure EPSON PhotoQuicker 
is installed in your computer. To download 
images from you memory card, make sure 
EPSON AutoDownloader is installed in your 
computer. For installation instructions, see 
“Installing the Software in Windows” on page 11, 
or “Installing the Software on a Macintosh” on 
page 13.

If the computer’s power save feature turns on 
while the camera is connected, the camera may 
automatically turn off causing it to be 
disconnected. Try connecting the camera to the 
computer again. To avoid this problem, do not use 
your computer’s power save feature when 
connecting the camera.

EPSON CameraStarter does not start.

Make sure the memory card has been used in a 
PhotoPC 2100Z or PhotoPC 3100Z. Memory cards 
formatted by other devices will not be recognized 
by EPSON CameraStarter.

Make sure EPSON CardMonitor is installed. For 
installation instructions, see “Installing the 
Software in Windows” on page 11 or “Installing 
the Software on a Macintosh” on page 13.

Make sure your PhotoPC 2100Z or PhotoPC 
3100Z is correctly connected to your computer 
and is turned on. For instructions on connecting 
the PhotoPC 2100Z, see “Connecting the camera 
to your computer” on page 18. For PhotoPC 3100Z 
users, see the User’s Guide for that camera.

Make sure the batteries in the camera have 
sufficient power, or use the optional AC adapter.
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If the computer’s power save feature turns on 
while the camera is connected, the camera may 
automatically turn off causing it to be 
disconnected. Try connecting the camera to the 
computer again. To avoid this problem, do not use 
your computer’s power save feature when 
connecting the camera.

EPSON PhotoQuicker does not start.

Make sure that EPSON PhotoQuicker is installed 
in your computer. For installation instructions, 
see “Installing the Software in Windows” on page 
11 or “Installing the Software on a Macintosh” on 
page 13.

On the Macintosh, to start EPSON PhotoQuicker 
from within EPSON Photo!4, make sure that there 
are 128 MB of memory available in your system. 
To change the amount of available system 
memory on your Macintosh, see your computer’s 
documentation. 

If you cannot make 128 MB of system memory 
available in your Macintosh, first transfer the 
images to your computer using EPSON 
AutoDownloader, close all applications, then 
start EPSON PhotoQuicker. For information on 
using EPSON AutoDownloader, see “Using 
EPSON AutoDownloader to Transfer Images” on 
page 22.
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Contacting Customer Support

If your EPSON product is not operating properly 
and you cannot solve the problem using the 
troubleshooting information in your product 
documentation, contact customer support 
services for assistance. If customer support for 
your area is not listed below, contact the dealer 
where you purchased your product.

Customer support will be able to help you much 
more quickly if you give them the following 
information:

❏ Product serial number
(The serial number label is usually on the 
back of the product.)

❏ Product model

❏ Product software version
(Click About, Version Info, or similar button 
in the product software.)

❏ Brand and model of your computer

❏ Your computer operating system name and 
version

❏ Names and versions of the software 
applications you normally use with your 
product

For users in North America

If you purchased your printer in the United 
States or Canada, EPSON provides technical 
assistance 24 hours a day through the electronic 
support services and automated telephone 
services listed in the following table:

Service Access

World Wide Web From the Internet, you can reach 
EPSON Support at 
http://support.epson.com. At this 
site, you can download drivers 
and other files, look at 
documentation such as product 
brochures and user manuals, and 
access troubleshooting 
information.
Contacting Customer Support 56



To speak directly to a technical support 
representative, dial: (562) 276-1300 (U.S.), or 
(905) 709-9475 (Canada), 6 AM TO 6 PM, Pacific 
Time, Monday through Friday. Toll or long 
distance charges may apply.

Before you call, please have the following 
information ready:

❏ Product name 

❏ Product serial number

❏ Proof of purchase (such as a store receipt) 
and date of purchase

❏ Computer configuration

❏ Description of the problem

Note:
For help using any other software on your system, see 
the documentation for that software for technical 
support information.

You can purchase ink cartridges, ribbon 
cartridges, paper, manuals, and accessories from 
EPSON at (800) 873-7766 or visit our web site at 
http://www.epsonstore.com (U.S. sales only). In 
Canada, please call (800) 873-7766 for dealer 
referral.

EPSON Internet 
FTP Site

If you have Internet FTP capability, 
use your Web browser (or other 
software for FTP downloading) to 
log onto ftp.epson.com with the 
user name anonymous and your 
e-mail address as the password.

EPSON E-MAIL 
Technical 
Support

To receive technical advice 
through e-mail, go to 
http://support.epson.com and 
complete the form under the 
troubleshooting tab, as 
requested.

Automated 
Telephone 
Services

A variety of automated help 
services are available 24 hours a 
day, seven days a week. To use 
these services, you must have a 
touch tone telephone and call 
(800) 922-8911.

Service Access
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For users in the United Kingdom and 
the Republic of Ireland

http://www.epson.co.uk

Visit our Internet home page for a full list of 
support and warranty services including:

❏ Register your product on-line

❏ Free access to the latest EPSON software 
drivers

❏ Easy access to frequently asked questions

❏ Interactive web based support tool to help 
you quickly resolve support issues

❏ Chat directly with a support technician 
on-line

❏ Email Technical Support

Support Via Telephone

❏ Other Products:UK 08701 637 766
The Republic of Ireland 01 679 9015 

Pre-Sales Enquiries, Literature Requests and 
Nearest Dealer

❏ Home Page:http://www.epson.co.uk

❏ Email:info@epson.co.uk

❏ Telephone:UK 0800 220 546
The Republic of Ireland 1 800 409 132 

❏ Fax:UK 01442 227271
The Republic of Ireland 00 44 1442 227 271
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For users in the Middle East

Some of these services may be available in 
English only.

http://www.epson.com

Select your country from our Internet home page 
for a full list of support and warranty services 
including:

❏ Register your product on-line

❏ Free access to the latest EPSON software 
drivers

❏ Easy access to frequently asked questions

❏ Interactive web based support tool to help 
you quickly resolve support issues

❏ Chat directly with a support technician 
on-line

❏ Email Technical Support

Technical Support Via Email and Telephone

❏ Email:epson_support@compubase.co.ae

❏ Telephone:+971 4 351 7777

❏ Fax:+971 4 351 6617 

Pre-Sales Enquiries, Literature Requests and 
Nearest Dealer

Select your country from our
Internet home page at
http://www.epson.com.

For users in Scandinavia

Some of these services may be available in 
English only.

http://www.epson.com

Select your country from our Internet home page 
for a full list of support and warranty services 
including:
Contacting Customer Support 59



❏ Register your product on-line

❏ Free access to the latest EPSON software 
drivers

❏ Easy access to frequently asked questions

❏ Interactive web based support tool to help 
you quickly resolve support issues

❏ Chat directly with a support technician 
on-line

❏ Email Technical Support

Support Via Telephone

❏ Denmark 80 88 11 27Finland 0800 523 010
Norway 800 11 828Sweden 08 445 12 58

Pre-Sales Enquiries Literature Requests and 
Nearest Dealer

❏ DenmarkHome Page: 
http://www.epson.dk
Telephone:38 48 71 37

❏ FinlandHome Page:
http://www.epson.fi
Telephone:0981 710 083

❏ NorwayHome Page:
http://www.epson.no
Telephone:231 62 124

❏ SwedenHome Page:
http://www.epson.se
Telephone:08 519 92 082

For users in South Africa

Some of these services may be available in 
English only.

http://www.epson.co.za

Visit our Internet home page for a full list of 
support and warranty services including:

❏ Register your product on-line
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❏ Free access to the latest EPSON software 
drivers

❏ Easy access to frequently asked questions

❏ Interactive web based support tool to help 
you quickly resolve support issues

❏ Chat directly with a support technician 
on-line

❏ Email Technical Support

Support Via Telephone

❏ Telephone: (011) 444-5223 or 0800 600 578

Pre-Sales Enquiries Literature Requests and 
Nearest Dealer

❏ Home Page: http://www.epson.co.za

❏ Telephone: (011) 448-2736 or 0800 005 956

For users in Australia

EPSON Australia wishes to provide you with a 
high level of customer service. In addition to 
your product documentation, we provide the 
following sources for obtaining information:

Your Dealer

Don’t forget that your dealer can often help 
identify and resolve problems. The dealer should 
always be the first call for advise on problems; 
they can often solve problems quickly and easily 
as well as give advise on the next step to take.

Internet URL http://www.epson.com.au

Access the EPSON Australia World Wide Web 
pages. Worth taking your modem here for the 
occasional surf! The site provides a download 
area for drivers, EPSON contact points, new 
product information and technical support 
(e-mail).
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EPSON Faxback Service

EPSON Faxback service will fax you the latest 
specifications for most EPSON products offered 
in Australia. Phone (02) 9903 9075 and the system 
will guide you through a number of choices 
before faxing the information to your fax 
machine.

EPSON Helpdesk

EPSON Helpdesk is provided as a final backup 
to make sure our clients have access to advise. 
Operators on the Helpdesk can aid you in 
installing, configuring and operating your 
EPSON product. Our Pre-sales Helpdesk staff 
can provide literature on new EPSON products 
and advise where the nearest dealer or service 
agent is located. Many types of queries are 
answered here.

The Helpdesk numbers are:

We encourage you to have all the relevant 
information on hand when you ring. The more 
information you prepare, the faster we can help 
solve the problem. This information includes 
your EPSON product documentation, type of 
computer, operating system, application 
programs, and any information you feel is 
required.

For users in Singapore

Sources of information, support, and services 
available from Epson Singapore are:

World Wide Web (http://www.epson.com.sg)

Information on product specifications, drivers 
for download, Frequently Asked Questions 
(FAQ), Sales Enquiries, and Technical Support 
via e-mail are available.

Phone: 1300 361 054

Fax: (02) 9903 9189
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Epson HelpDesk (Phone: (065) 5863111)

Our HelpDesk team can help you with the 
following over the phone:

❏ Sales enquiries and product information

❏ Product usage questions or problem

❏ Enquiries on repair service and warranty

For users in Thailand

Contact for information, support, and services 
are:

World Wide Web (http://www.epson.co.th)

Information on product specifications, drivers 
for download, Frequently Asked Questions 
(FAQ), and e-mail are available.

Epson Hotline (Phone: (662) 670-0333)

Our Hotline team can help you with the 
following over the phone:

❏ Sales enquiries and product information

❏ Product usage questions or problem

❏ Enquiries on repair service and warranty

For users in Indonesia

Contacts for information, support, and services 
are:

World Wide Web 
(http://epson-indonesia.com)

❏ Information on product specifications, 
drivers for download

❏ Frequently Asked Question (FAQ), Sales 
Enquires, questions through e-mail
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Epson Hotline

❏ Sales enquires and product information

❏ Technical support

For users in Hong Kong

To obtain technical support as well as other 
after-sales services, users are welcome to contact 
EPSON Hong Kong Limited.

Internet Home Page

EPSON Hong Kong has established a local home 
page in both Chinese and English on the Internet 
to provide users with the following information:

❏ Product information

❏ Answers to Frequently Asked Questions 
(FAQs)

❏ Latest versions of EPSON product drivers

Users can access our World Wide Web home 
page at:

http://www.epson.com.hk

Electronic Bulletin Board System

An electronic bulletin board system (BBS) is also 
available to obtain product information and the 
latest versions of product drivers. You can log on 
to the following number for the BBS service:

Technical Support Hotline

You can also contact our technical staff at the 
following telephone and fax numbers:

Phone 62 21 5724350

Fax 62 21 5724357

BBS: (852) 2827-4244

Phone: (852) 2585-4399

Fax: (852) 2827-4383
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For users in Malaysia

Contacts for information, support, and services 
are:

World Wide Web (http://www.epson.com.my)

Information on product specifications, drivers 
for download, Frequently Asked Questions 
(FAQ), and Email Enquiries are available.

Epson Trading Shah Alam Head Office

For users in India

Contacts for information, support, and services 
are:

World Wide Web (http://www.epson.co.in)

Information on product specifications, drivers 
for download, Frequently Asked Questions 
(FAQ), Products Enquiry, and Technical Query 
are available.

Epson India Head Office - Bangalore:
Phone: 03 5191366

Fax: 03 5191281
Phone: 5321 266-70

Fax: 5581799/5321095

Help Desk 
Phone:

5321 625
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Epson India Regional Offices: For users in the Philippines

To obtain technical support as well as other after 
sales services, users are welcome to contact the 
EPSON Philippines Representative Office at the 
telephone and fax numbers below:

Mumbai Phone: 8261516-17
Fax: 8257287
Help Desk Phone: 8261515

Delhi Phone: 3352051-53
Fax: 3352054
Help Desk Phone: 3706222

Chennai Phone: 8203940-41
Fax: 8272463
Help Desk Phone: 8218659

Kolkata Phone: 2871355
Fax: 2871357
Help Desk Phone: 2404932

Phone: (632) 813-6552

Fax: (632) 813-6545

BBS: (632) 814-0595
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Glossary

application
A software program that helps you carry out a particular task, 
such as word processing or financial planning.

BMP
A Windows file format for storing image data.

default
A value or setting that takes effect when the equipment is turned 
on, reset, or initialized. Also known as a factory setting.

drag-and-drop
Method for moving an on-screen object by holding the pointer 
over the object, pressing and holding the mouse button, 
dragging the mouse, then releasing the mouse button to drop 
the object in a new location.

Design rule for camera file system
Recording standard for image files. This standard has been 
established by the Japan Electronics and Information 
Technology Industries Association (JEITA).

DPOF 
Digital Print Order Format. Settings for the number of prints are 
saved in a DPOF file on the camera's memory card. You can 
apply these settings when using a printer or printing application 
that supports the DPOF standard.

Exif2.1
Standard format for audio/image files. This standard has been 
established by the Japan Electronics and Information 
Technology Industries Association (JEITA). 

grayscale
Images represented using various shades of gray in addition to 
black and white.

interface
The connection between the computer and the camera.

JPEG
A file format used for storing color and grayscale images in 
compressed files. Data saved using the JPEG format generally 
receives greater compression than data saved using TIFF and 
other formats. See TIFF.

PICT
A file format widely used for Macintosh graphics.

pixel
Short for picture element. Each image is composed of a 
number of pixels. Pixels are also counted in units of dots.

port
An interface channel through which data is transmitted between 
devices.
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PRINT Image Matching
A new standard that allows digital cameras to record special 
information about the photos it takes and relay that information 
seamlessly to a printer compatible with this standard. This 
information can be used by printers that support the PRINT 
Image Matching system for enhanced printing results.

resolution
Indication of how finely an image is resolved into pixels. Often 
measured in dots per inch (dpi) or pixels per inch (ppi).

thumbnails
Small representations of images.

TIFF
A file format for storing color and grayscale images in files with 
little or no data compression. (TIFF files made with EPSON 
digital cameras receive no data compression.) Saving data in the 
TIFF format results in files that are larger and have finer image 
quality than image files with greater data compression, such as 
JPEG and other format files. See JPEG.

USB
Universal Serial Bus. A hardware interface for connecting one 
or more low-speed peripherals, such as a keyboard, mouse, 
scanner, or printer, to the computer.

USB hub
A device that normally provides four TYPE A sockets to increase 
the number of USB ports on a computer.
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Index

A
Acrobat Reader

installing in Windows, 11
installing on Macintosh, 14

Adding user comments to images, 40
Advanced menu, 23, 24
Audio recordings

locking, 38
sending via e-mail, 42
unlocking, 38
uploading to a CompactFlash Card, 40

Auto shut-off, 19

B
Base Folder, 28
Buttons

changing thumbnail view, 29
control panel for slide show, 37
hiding image information, 31
Image Viewer window, 34
opening images, 34, 35
photo info, 31
rotation, 41
selecting all images, 29
showing image information, 31

C
Camera

connecting to your computer, 18
disconnecting from a Macintosh, 22
disconnecting from Windows 2000, 21
disconnecting from Windows Me and 98, 21

Camera Card drive, 28
Camera ID, 31
Camera indicator lights, 20
Changing file names, 39
Changing folder names, 39
CompactFlash memory card

downloading files from, 22
uploading files to, 40

Connecting the camera to your computer, 18
Contacting EPSON, 56
Copying files, 40
Customer support, 56

D
Deleting files, 39
Details View menu, 31
Disconnecting the camera

from a Macintosh, 22
from Windows 2000, 21
from Windows Me and 98, 21
Index 69



Downloading files from a CompactFlash memory card, 22
DPOF settings, 48
Drives

Camera Card, 28
EPSON Camera, 28
selecting in EPSON Photo!4, 27
Source Drive, 47

E
EPSON AutoDownloader

accessing from EPSON CameraStarter, 24
accessing from Macintosh, 23
accessing from Windows, 22
installing in Windows, 11
installing on Macintosh, 13

EPSON Camera drive, 28
EPSON CameraStarter

features, 15
installing in Windows, 11
installing on Macintosh, 13
using, 46

EPSON CardMonitor
installing in Windows, 11
installing on Macintosh, 13

EPSON Photo!4
accessing, 26
adding user comments, 40
changing file names, 39
changing folder names, 39
copying files, 40
deleting files, 39
Image Viewer window, 33

installing in Windows, 11
installing on Macintosh, 13
locking files, 38
moving files, 39
printing photos, 44
rotating photos, 41
search function, 38
selecting drives, 27
selecting folders, 27
selecting images, 29
sending files via e-mail, 42
slide show, 35
unlocking files, 38
uploading files to a CompactFlash memory card, 40
using a photo as wallpaper, 42
viewing a list of files, 29
viewing image information, 29
viewing thumbnail images, 29

EPSON Photo file format image files, 28
EPSON PhotoQuicker

accessing, 44, 49
installing in Windows, 11
installing on Macintosh, 13

F
File formats

JPEG, 30, 31
TIFF, 30, 31

Files and Folders menu, 23, 24
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Folders
Base Folder, 28
changing names, 39
Recent Search Results, 28, 38
selecting in EPSON Photo!4, 27

I
Icons

image information in a list of files, 31
image information in thumbnails, 30

Image information
changing items shown, 31
viewing in a list of files, 31
viewing in thumbnails, 30
viewing using the Properties dialog box, 32

Image Viewer window
buttons, 34
using, 33

Indicator lights, 20
Installing

Acrobat Reader in Windows, 11
Acrobat Reader on Macintosh, 14
EPSON AutoDownloader in Windows, 11
EPSON AutoDownloader on Macintosh, 13
EPSON CameraStarter in Windows, 11
EPSON CameraStarter on Macintosh, 13
EPSON CardMonitor in Windows, 11
EPSON CardMonitor on Macintosh, 13
EPSON Photo!4 in Windows, 11
EPSON Photo!4 on Macintosh, 13
EPSON PhotoQuicker in Windows, 11
EPSON PhotoQuicker on Macintosh, 13

Panorama Stitcher Light EP in Windows, 11
Panorama Stitcher Light EP on Macintosh, 13
Software in Windows, 11
Software on Macintosh, 13
USB driver in Windows, 11
USB driver on Macintosh, 13

J
JPEG file format, 30, 31

L
Locking files, 38

M
Memory card, See CompactFlash Card
Menus

Advanced, 23, 24
Details View, 31
Files and Folders, 23, 24
Slide show, 36

Moving files, 39
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P
Photos

adding user comments to, 40
changing file names, 39
copying, 40
deleting, 39
getting information on, 31
locking, 38
moving, 39
printing, 44
rotating, 41
selecting, 29
sending via e-mail, 42
unlocking, 38
using as wallpaper, 42
viewing information, 29
viewing properties, 32
viewing thumbnails, 29

Pictures, See Photos
Printing photos, 44

R
Recent Search Results folder, 28, 38
Rotating photos, 41
Running a slide show, 37

S
Search function, 38
Selecting

drives in EPSON Photo!4, 27
folders in EPSON Photo!4, 27

images in EPSON Photo!4, 29
Sending files via e-mail, 42
Settings

Base Folder, 28
changing image information items shown, 31
slide show, 36

Slide show
buttons in the control panel, 37
running, 37
settings, 36

Slide show menu, 36
Software

installing in Windows, 11
installing on Macintosh, 13

Source Drive, 47
System requirements

for Macintosh, 8

T
Technical support, 56
TIFF file format, 30, 31
Troubleshooting, 51

U
Unlocking files, 38
Uploading files to a CompactFlash memory card, 40
USB cable, 18, 21
USB driver

installing in Windows, 11
installing on Macintosh, 13

User comments, 33, 40
Using a photo as wallpaper, 42
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V
Video clips

adding user comments to, 40
changing file names, 39
copying, 40
deleting, 39
locking, 38
moving, 39
selecting, 29
sending via e-mail, 42
unlocking, 38
viewing information, 29
viewing properties, 32
viewing thumbnails, 29

Viewing
a list of files, 29
image information in a list of files, 31
image information in thumbnails, 30
image information using the Properties dialog box, 32
images in the Image Viewer window, 33
photo information, 31
properties, 32
thumbnail images, 29
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